
QGIS Application - Issues

# Tracker Status Priority Subject Assignee Updated# Tracker Status Priority Subject Assignee Updated

22115 Bug report Open High Moving a panel over another in dual-screen workspace crashes the app 2019-05-21 05:30 PM

22115 Bug report Open High Moving a panel over another in dual-screen workspace crashes the app 2019-05-21 05:30 PM

22096 Bug report Open Normal Panels not docking and some invisible 2019-05-17 05:16 PM

22096 Bug report Open Normal Panels not docking and some invisible 2019-05-17 05:16 PM

22091 Bug report Feedback High Crash 2019-05-17 07:34 PM

22091 Bug report Feedback High Crash 2019-05-17 07:34 PM

22090 Bug report Feedback Normal Dialog when removing not available layers 2019-05-17 07:44 PM

22090 Bug report Feedback Normal Dialog when removing not available layers 2019-05-17 07:44 PM

22084 Bug report Feedback Normal Tool Icons disappear from menu 2019-05-18 12:25 PM

22084 Bug report Feedback Normal Tool Icons disappear from menu 2019-05-18 12:25 PM

22068 Bug report Open Normal Layer Properties- Attributes Form (Width) 2019-05-14 09:14 AM

22068 Bug report Open Normal Layer Properties- Attributes Form (Width) 2019-05-14 09:14 AM

22057 Bug report Open Normal "Load/Save" connections 2019-05-13 01:41 AM

22057 Bug report Open Normal "Load/Save" connections 2019-05-13 01:41 AM

22056 Feature request Open Normal Consistent layer adding for services 2019-05-13 01:28 AM

22056 Feature request Open Normal Consistent layer adding for services 2019-05-13 01:28 AM

21984 Bug report Open Normal The composer export functions don't remember last used path on mapped network drives 2019-05-03 10:01 AM

21984 Bug report Open Normal The composer export functions don't remember last used path on mapped network drives 2019-05-03 10:01 AM

21972 Bug report Open Low inside the Layer's panel, can't see if a layer is checked or not, when its line is highlighted (in dark blue) 2019-05-02 10:29 AM

21972 Bug report Open Low inside the Layer's panel, can't see if a layer is checked or not, when its line is highlighted (in dark blue) 2019-05-02 10:29 AM

21950 Bug report Open Normal layer properties panel hides labels 2019-05-01 06:01 PM

21950 Bug report Open Normal layer properties panel hides labels 2019-05-01 06:01 PM

21936 Bug report Open Low Snapping Settings window with Night Mapping, low readability 2019-04-26 12:24 PM

21936 Bug report Open Low Snapping Settings window with Night Mapping, low readability 2019-04-26 12:24 PM

21918 Bug report Open Normal QgsCollapsibleGroupBox - QtEditor - Editing of child widgets fails when box is collapsed 2019-04-24 12:07 PM

21918 Bug report Open Normal QgsCollapsibleGroupBox - QtEditor - Editing of child widgets fails when box is collapsed 2019-04-24 12:07 PM

21894 Bug report Open Normal Selected sub-item of Join doesn't count for editing 2019-04-23 08:58 AM

21894 Bug report Open Normal Selected sub-item of Join doesn't count for editing 2019-04-23 08:58 AM

21893 Bug report Open Normal Selected join isn't visually selected Matthias Kuhn 2019-04-23 08:52 AM

21893 Bug report Open Normal Selected join isn't visually selected Matthias Kuhn 2019-04-23 08:52 AM

21883 Bug report Open Normal Clearing Multiple QGIS Warnings takes inordinately long 2019-04-18 04:41 PM

21883 Bug report Open Normal Clearing Multiple QGIS Warnings takes inordinately long 2019-04-18 04:41 PM

21879 Bug report Open High Dragging layers too high in layers panel will reload them, potentially losing data 2019-04-18 01:38 PM

21879 Bug report Open High Dragging layers too high in layers panel will reload them, potentially losing data 2019-04-18 01:38 PM

21850 Bug report Feedback Normal QGIS crashed after abort a plugin process 2019-04-16 12:49 AM

21850 Bug report Feedback Normal QGIS crashed after abort a plugin process 2019-04-16 12:49 AM

21800 Feature request Open Low Layer Order panel: support for groups? 2019-04-08 06:57 PM

21800 Feature request Open Low Layer Order panel: support for groups? 2019-04-08 06:57 PM

21799 Bug report Open Normal Layer Order panel: moving a layer scrolling  slows down when many layers present 2019-04-10 05:39 PM

21799 Bug report Open Normal Layer Order panel: moving a layer scrolling  slows down when many layers present 2019-04-10 05:39 PM

21795 Feature request Open Normal Improvements to Query Builder 2019-04-08 04:26 PM

21795 Feature request Open Normal Improvements to Query Builder 2019-04-08 04:26 PM

21794 Feature request Open Normal Improvements to Joins/Relates 2019-04-08 04:21 PM

21794 Feature request Open Normal Improvements to Joins/Relates 2019-04-08 04:21 PM

21778 Feature request Open Normal Activate as predefined, the "preview" tab in the properties of the vector layers 2019-04-05 08:36 PM

21778 Feature request Open Normal Activate as predefined, the "preview" tab in the properties of the vector layers 2019-04-05 08:36 PM

21767 Feature request Open Normal Zoom to feature(s) 2019-04-08 03:24 PM

21767 Feature request Open Normal Zoom to feature(s) 2019-04-08 03:24 PM

21731 Bug report Feedback Normal Fixed minimum width of Identify Results Dialog 2019-04-02 12:52 PM

21731 Bug report Feedback Normal Fixed minimum width of Identify Results Dialog 2019-04-02 12:52 PM

21727 Bug report Open Normal Feature attribute selection design bug 2019-04-02 01:29 PM

21727 Bug report Open Normal Feature attribute selection design bug 2019-04-02 01:29 PM

21713 Bug report Open Normal unvisible mouse cursor on specific backgrounds 2019-05-01 11:19 AM

21713 Bug report Open Normal unvisible mouse cursor on specific backgrounds 2019-05-01 11:19 AM

21647 Feature request Open Normal Log Messages Panel dockable to other locations 2019-03-21 04:50 PM

21647 Feature request Open Normal Log Messages Panel dockable to other locations 2019-03-21 04:50 PM

21646 Feature request Open Normal Results & Processing History tie-in 2019-03-21 04:38 PM

21646 Feature request Open Normal Results & Processing History tie-in 2019-03-21 04:38 PM

21645 Feature request Open Normal Processing History Dockable Panel 2019-03-21 04:33 PM

21645 Feature request Open Normal Processing History Dockable Panel 2019-03-21 04:33 PM

21644 Bug report Open Normal Python Console Panel does not respect location/status across QGIS sessions 2019-03-21 04:48 PM

21644 Bug report Open Normal Python Console Panel does not respect location/status across QGIS sessions 2019-03-21 04:48 PM

21643 Feature request Open Normal ESRI-like Layer Aliases in layer/feature selection lists 2019-03-21 04:21 PM

21643 Feature request Open Normal ESRI-like Layer Aliases in layer/feature selection lists 2019-03-21 04:21 PM

21642 Feature request Open Normal Show filtered/total/selected with Show Feature Count 2019-03-21 04:16 PM

21642 Feature request Open Normal Show filtered/total/selected with Show Feature Count 2019-03-21 04:16 PM

21641 Feature request Open Normal Show Feature Count for Group Objects 2019-03-21 04:09 PM

21641 Feature request Open Normal Show Feature Count for Group Objects 2019-03-21 04:09 PM

21640 Feature request Open Normal Option to set Layers list default behaviors 2019-03-21 04:06 PM

21640 Feature request Open Normal Option to set Layers list default behaviors 2019-03-21 04:06 PM

21607 Feature request Open Normal Different GNSS Status indication 2019-03-18 12:26 AM

21607 Feature request Open Normal Different GNSS Status indication 2019-03-18 12:26 AM

21476 Bug report Feedback Normal Vertex editor panel keeps popping up 2019-03-06 10:16 AM

21476 Bug report Feedback Normal Vertex editor panel keeps popping up 2019-03-06 10:16 AM

21465 Feature request Open Normal Please allow resizing on style manager in the right panel on QGIS interface 2019-03-04 10:22 AM

21465 Feature request Open Normal Please allow resizing on style manager in the right panel on QGIS interface 2019-03-04 10:22 AM

21464 Bug report Reopened Normal option --profiles-path when launching QGIS and locale by default involve Qvariant error when activating plugins 2019-03-04 03:12 PM

21464 Bug report Reopened Normal option --profiles-path when launching QGIS and locale by default involve Qvariant error when activating plugins 2019-03-04 03:12 PM

21399 Feature request Open Low "There is a new QGIS version available. Visit...." always visible on Mac OS 2019-02-27 12:00 AM

21399 Feature request Open Low "There is a new QGIS version available. Visit...." always visible on Mac OS 2019-02-27 12:00 AM

21370 Feature request Open Normal geometry precision by default for new layer 2019-02-25 10:01 AM

21370 Feature request Open Normal geometry precision by default for new layer 2019-02-25 10:01 AM

21357 Bug report Open High Select fields group text garbled when switching format in Save Vector Layer As dialog 2019-03-05 04:31 PM
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21357 Bug report Open High Select fields group text garbled when switching format in Save Vector Layer As dialog 2019-03-05 04:31 PM

21314 Bug report Open Normal [Expression] The help in the Function Editor panel is unreadable due to coloring 2019-02-19 04:38 PM

21314 Bug report Open Normal [Expression] The help in the Function Editor panel is unreadable due to coloring 2019-02-19 04:38 PM

21313 Feature request Open Normal Consideration of CPG files for encoding shape files 2019-04-09 12:55 PM

21313 Feature request Open Normal Consideration of CPG files for encoding shape files 2019-04-09 12:55 PM

21289 Feature request Open Normal Processing Modeler Snap Feature 2019-02-15 05:41 PM

21289 Feature request Open Normal Processing Modeler Snap Feature 2019-02-15 05:41 PM

21238 Feature request Open Normal Windows Taskbar Progress Overlay 2019-02-11 08:32 PM

21238 Feature request Open Normal Windows Taskbar Progress Overlay 2019-02-11 08:32 PM

21229 Bug report Open Normal File dialogs in FlatPak version of QGIS revert to default directory 2019-02-11 02:42 PM

21229 Bug report Open Normal File dialogs in FlatPak version of QGIS revert to default directory 2019-02-11 02:42 PM

21212 Bug report Open Normal Close and Restore buttons in panel windows look "too bold" 2019-03-20 01:25 AM

21212 Bug report Open Normal Close and Restore buttons in panel windows look "too bold" 2019-03-20 01:25 AM

21203 Bug report Open Normal ']' keyboard (alt-gr + '+' ) not working on QGis 3.4.4 with Spanish or Italian keyboard - Windows 2019-02-11 08:36 AM

21203 Bug report Open Normal ']' keyboard (alt-gr + '+' ) not working on QGis 3.4.4 with Spanish or Italian keyboard - Windows 2019-02-11 08:36 AM

21190 Bug report Open Normal Layer Properties 'displayed as' value shows CamelCase Layer name, but is never used? 2019-02-06 10:28 PM

21190 Bug report Open Normal Layer Properties 'displayed as' value shows CamelCase Layer name, but is never used? 2019-02-06 10:28 PM

21076 Bug report Open Normal QGIS 3.4.3 window will not appear over any other app! 2019-01-23 03:19 AM

21076 Bug report Open Normal QGIS 3.4.3 window will not appear over any other app! 2019-01-23 03:19 AM

21066 Bug report Open Low Black theme in not acivated after restart QGIS 2019-02-11 12:52 PM

21066 Bug report Open Low Black theme in not acivated after restart QGIS 2019-02-11 12:52 PM

20949 Feature request Open Normal Layer panel - make it easier for users to detect that a layer has multi-geometries 2019-01-17 11:53 AM

20949 Feature request Open Normal Layer panel - make it easier for users to detect that a layer has multi-geometries 2019-01-17 11:53 AM

20946 Bug report Open Normal bug: raster layer style shown in "Layers" panel is not updated when style is changed from the "Style Manager" tab in the Layer 

Styling panel

2019-01-28 10:59 AM

20946 Bug report Open Normal bug: raster layer style shown in "Layers" panel is not updated when style is changed from the "Style Manager" tab in the Layer 

Styling panel

2019-01-28 10:59 AM

20839 Bug report Open Normal QgsCheckableComboBox single item selection bug 2018-12-18 02:34 PM

20839 Bug report Open Normal QgsCheckableComboBox single item selection bug 2018-12-18 02:34 PM

20836 Bug report Open Normal Deactivate "Open ""... entry in "Recent projects" list for unavailable projects 2019-03-02 09:19 AM

20836 Bug report Open Normal Deactivate "Open ""... entry in "Recent projects" list for unavailable projects 2019-03-02 09:19 AM

20833 Feature request Open Normal Filtering groups of layers 2018-12-18 09:46 AM

20833 Feature request Open Normal Filtering groups of layers 2018-12-18 09:46 AM

20802 Bug report Feedback High crashed by export 2019-03-09 04:51 PM

20802 Bug report Feedback High crashed by export 2019-03-09 04:51 PM

20780 Bug report Open Normal Cannot copy text in QGIS 3.4.2 with either Ctrl-C or by context menu 2018-12-11 08:36 PM

20780 Bug report Open Normal Cannot copy text in QGIS 3.4.2 with either Ctrl-C or by context menu 2018-12-11 08:36 PM

20776 Bug report Open Normal Symmetric classification collapsible group in symbology --> graduated renderer behaves weirdly 2018-12-11 04:22 PM

20776 Bug report Open Normal Symmetric classification collapsible group in symbology --> graduated renderer behaves weirdly 2018-12-11 04:22 PM

20750 Bug report Open Low Drag and drop designer with confusing layout 2018-12-07 12:28 PM

20750 Bug report Open Low Drag and drop designer with confusing layout 2018-12-07 12:28 PM

20709 Feature request Open Normal Adjust window docking tolerances 2018-12-03 11:27 PM

20709 Feature request Open Normal Adjust window docking tolerances 2018-12-03 11:27 PM

20708 Feature request Open Normal Allow editing of field alias in Layer Properties - Fields tab 2018-12-03 04:21 PM

20708 Feature request Open Normal Allow editing of field alias in Layer Properties - Fields tab 2018-12-03 04:21 PM

20690 Bug report Open Normal QGIS 3.4.2 Crash on Windows with multiple monitors 2018-12-01 12:48 PM

20690 Bug report Open Normal QGIS 3.4.2 Crash on Windows with multiple monitors 2018-12-01 12:48 PM

20630 Bug report Open Normal Missing "Opacity" and "Blend mode" options when using Transform Effect 2018-11-26 12:24 PM

20630 Bug report Open Normal Missing "Opacity" and "Blend mode" options when using Transform Effect 2018-11-26 12:24 PM

20585 Bug report Open Normal When handle bad layers responded to with new datasource. The layer name does not update in the layers list. 2018-11-22 05:26 AM

20585 Bug report Open Normal When handle bad layers responded to with new datasource. The layer name does not update in the layers list. 2018-11-22 05:26 AM

20527 Bug report Open Normal CRASH: MainMenu->Measure->Configuration->Set Decimal units display to 6 2018-11-17 12:27 PM

20527 Bug report Open Normal CRASH: MainMenu->Measure->Configuration->Set Decimal units display to 6 2018-11-17 12:27 PM

20417 Bug report Open Normal Advanced Digitizing Panel 2018-11-08 06:04 PM

20417 Bug report Open Normal Advanced Digitizing Panel 2018-11-08 06:04 PM

20322 Feature request Open Low save path of menu when right clicking  on a menu or icons 2018-11-01 08:00 PM

20322 Feature request Open Low save path of menu when right clicking  on a menu or icons 2018-11-01 08:00 PM

20216 Feature request Open Normal Drop-down menu for adding line object features 2018-10-25 07:03 PM

20216 Feature request Open Normal Drop-down menu for adding line object features 2018-10-25 07:03 PM

20215 Bug report Open Low Coordinate widget on status bar doesn't display whole numbers 2018-10-25 11:53 PM

20215 Bug report Open Low Coordinate widget on status bar doesn't display whole numbers 2018-10-25 11:53 PM

20181 Feature request Open Normal [mdal] Open Meshes from the command-line 2018-10-22 03:25 PM

20181 Feature request Open Normal [mdal] Open Meshes from the command-line 2018-10-22 03:25 PM

20177 Bug report Open Normal [mdal] Not possible to delete extra-dataset 2018-10-22 10:15 AM

20177 Bug report Open Normal [mdal] Not possible to delete extra-dataset 2018-10-22 10:15 AM

20149 Bug report Open Normal Postgis provider dialog does not show empty schema's 2018-10-18 11:12 AM

20149 Bug report Open Normal Postgis provider dialog does not show empty schema's 2018-10-18 11:12 AM

20145 Bug report Open Normal [mdal][gui] Remove unused buttons for displaying contours and vectors 2018-10-17 09:39 PM

20145 Bug report Open Normal [mdal][gui] Remove unused buttons for displaying contours and vectors 2018-10-17 09:39 PM

20144 Bug report Open Normal [mdal][gui] Usability issue with activating/deactivating quantities 2018-10-17 09:20 PM

20144 Bug report Open Normal [mdal][gui] Usability issue with activating/deactivating quantities 2018-10-17 09:20 PM

20127 Bug report Open Normal [Processing] Esri shapefile format is listed twice in file selector dialog when running in batch 2018-10-17 01:48 PM

20127 Bug report Open Normal [Processing] Esri shapefile format is listed twice in file selector dialog when running in batch 2018-10-17 01:48 PM

20121 Bug report Open Normal Inconsistent placement of Cancel button in Load Style window 2018-10-16 11:48 AM

20121 Bug report Open Normal Inconsistent placement of Cancel button in Load Style window 2018-10-16 11:48 AM

20120 Bug report Open Normal Remembering the last folder when loading style 2018-10-16 11:44 AM

20120 Bug report Open Normal Remembering the last folder when loading style 2018-10-16 11:44 AM

20117 Feature request Open Normal Saving edits as background task 2018-10-16 08:06 AM

20117 Feature request Open Normal Saving edits as background task 2018-10-16 08:06 AM

20102 Feature request Feedback Normal Pre-render canvas outside of visible area 2018-10-19 06:26 PM

20102 Feature request Feedback Normal Pre-render canvas outside of visible area 2018-10-19 06:26 PM

20083 Feature request Feedback Normal Eliminate multiple dialog levels in Layer Properties 2018-10-12 06:41 AM

20083 Feature request Feedback Normal Eliminate multiple dialog levels in Layer Properties 2018-10-12 06:41 AM

20046 Bug report Open Normal Log Messages Panel disappears 2018-10-09 11:24 AM

20046 Bug report Open Normal Log Messages Panel disappears 2018-10-09 11:24 AM

19997 Bug report Open Normal Zoom from mac mousepad does not work 2018-10-02 01:54 PM
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19997 Bug report Open Normal Zoom from mac mousepad does not work 2018-10-02 01:54 PM

19970 Bug report Open Normal Different default M values depending on the function 2018-09-27 04:28 PM

19970 Bug report Open Normal Different default M values depending on the function 2018-09-27 04:28 PM

19955 Bug report Open Normal Window Position not save on Exit 2018-09-26 12:46 PM

19955 Bug report Open Normal Window Position not save on Exit 2018-09-26 12:46 PM

19924 Feature request Open Low Add "Annotation tool" entry in menu 2018-09-23 04:37 PM

19924 Feature request Open Low Add "Annotation tool" entry in menu 2018-09-23 04:37 PM

19864 Feature request Open Normal Data source Manager Inconsistency between the browser and left column 2018-09-17 11:45 AM

19864 Feature request Open Normal Data source Manager Inconsistency between the browser and left column 2018-09-17 11:45 AM

19777 Bug report Open Normal Exit "Select color" dialog do not close with escape key 2018-09-06 11:24 AM

19777 Bug report Open Normal Exit "Select color" dialog do not close with escape key 2018-09-06 11:24 AM

19697 Bug report Open Normal huge (giant) font size in Extension description window 2018-08-25 06:25 PM

19697 Bug report Open Normal huge (giant) font size in Extension description window 2018-08-25 06:25 PM

19592 Feature request Open Normal Move color wheel in symbology below drop down arrow or right-click position 2018-08-10 04:45 PM

19592 Feature request Open Normal Move color wheel in symbology below drop down arrow or right-click position 2018-08-10 04:45 PM

19585 Bug report Open Normal Single-letter shortcut doesn't work when attribute dialog is open 2018-08-10 08:46 AM

19585 Bug report Open Normal Single-letter shortcut doesn't work when attribute dialog is open 2018-08-10 08:46 AM

19572 Bug report Open Normal Locator window is very broad 2018-08-09 09:13 AM

19572 Bug report Open Normal Locator window is very broad 2018-08-09 09:13 AM

19543 Bug report Open Normal Small default size of Edit Attributes modal window. 2018-08-04 12:45 PM

19543 Bug report Open Normal Small default size of Edit Attributes modal window. 2018-08-04 12:45 PM

19520 Feature request Open Normal please turn Geodesic Measurement tool window into a QGIS Panel 2018-07-31 06:31 PM

19520 Feature request Open Normal please turn Geodesic Measurement tool window into a QGIS Panel 2018-07-31 06:31 PM

19491 Bug report Open Low Click in inactive QGIS window triggers actions! 2018-08-01 09:54 AM

19491 Bug report Open Low Click in inactive QGIS window triggers actions! 2018-08-01 09:54 AM

19456 Feature request Open Normal Non-blocking Database Manager dialogs 2018-07-20 04:54 PM

19456 Feature request Open Normal Non-blocking Database Manager dialogs 2018-07-20 04:54 PM

19430 Feature request Open Normal Mouse icon lagging behind on remote desktop 2018-07-17 09:26 AM

19430 Feature request Open Normal Mouse icon lagging behind on remote desktop 2018-07-17 09:26 AM

19418 Bug report Open Normal Redundant icons 2018-07-14 08:26 PM

19418 Bug report Open Normal Redundant icons 2018-07-14 08:26 PM

19386 Bug report Open Normal QGIS 3 does not save main window size and position (after being set as default app?) 2018-08-09 10:38 PM

19386 Bug report Open Normal QGIS 3 does not save main window size and position (after being set as default app?) 2018-08-09 10:38 PM

19300 Feature request Open Normal Could there be a way to default "Show Feature Count" to on for all layers? 2018-06-29 02:46 AM

19300 Feature request Open Normal Could there be a way to default "Show Feature Count" to on for all layers? 2018-06-29 02:46 AM

19222 Bug report Open Low Splash Screen Persists While 'Handle Bad Layers' Dialog is Open 2018-06-19 04:23 AM

19222 Bug report Open Low Splash Screen Persists While 'Handle Bad Layers' Dialog is Open 2018-06-19 04:23 AM

19206 Bug report Open Normal Ctrl+C doesn't copy, despite dialog prompt 2018-06-27 11:40 PM

19206 Bug report Open Normal Ctrl+C doesn't copy, despite dialog prompt 2018-06-27 11:40 PM

19095 Bug report Open Normal Data defined assistant dialogs do not use the right title case for their name 2018-06-02 12:58 PM

19095 Bug report Open Normal Data defined assistant dialogs do not use the right title case for their name 2018-06-02 12:58 PM

19090 Bug report Open Normal Inability to resize columns in 'handle bad layers' dialogue box 2018-06-01 09:51 PM

19090 Bug report Open Normal Inability to resize columns in 'handle bad layers' dialogue box 2018-06-01 09:51 PM

19081 Feature request Open Low Ability to clear Log Messages panel, and to reload it 2018-06-01 05:06 AM

19081 Feature request Open Low Ability to clear Log Messages panel, and to reload it 2018-06-01 05:06 AM

19075 Feature request Open Low Display file names when loading multiple GPX files to project 2018-05-31 09:46 PM

19075 Feature request Open Low Display file names when loading multiple GPX files to project 2018-05-31 09:46 PM

19019 Bug report Open Normal Toolbars reorganisation is not saved when QGIS is closed 2018-05-24 10:51 AM

19019 Bug report Open Normal Toolbars reorganisation is not saved when QGIS is closed 2018-05-24 10:51 AM

18995 Feature request Open Normal use variable in layer source 2018-06-11 01:27 PM

18995 Feature request Open Normal use variable in layer source 2018-06-11 01:27 PM

18949 Bug report Open Normal Data Source Manager - Filter does not consider the Name and Abstract fields when displaying ArcGIS Map Server and ArcGIS 

Feature Server layers

2018-05-14 07:58 AM

18949 Bug report Open Normal Data Source Manager - Filter does not consider the Name and Abstract fields when displaying ArcGIS Map Server and ArcGIS 

Feature Server layers

2018-05-14 07:58 AM

18925 Bug report Open Normal QGIS crashed while opening PostgreSQL layer 2018-05-08 08:42 AM

18925 Bug report Open Normal QGIS crashed while opening PostgreSQL layer 2018-05-08 08:42 AM

18924 Bug report Open Normal Measurement tool window not visible 2018-07-31 06:21 PM

18924 Bug report Open Normal Measurement tool window not visible 2018-07-31 06:21 PM

18811 Bug report Open Normal F7 shortcut does not open the Layers styling panel if the Layers panel is disabled 2018-04-26 01:31 PM

18811 Bug report Open Normal F7 shortcut does not open the Layers styling panel if the Layers panel is disabled 2018-04-26 01:31 PM

18810 Bug report Open Normal Two different default shortcuts for the Layer styling panel (F7 vs Ctrl+3) 2018-04-26 01:28 PM

18810 Bug report Open Normal Two different default shortcuts for the Layer styling panel (F7 vs Ctrl+3) 2018-04-26 01:28 PM

18783 Feature request Open Normal switch to turn off GPKG filename in layers tree 2018-04-21 01:23 PM

18783 Feature request Open Normal switch to turn off GPKG filename in layers tree 2018-04-21 01:23 PM

18758 Bug report Open Normal QGIS3: mysteric QByteArray display in dvanced Settings Editor 2018-04-18 08:57 PM

18758 Bug report Open Normal QGIS3: mysteric QByteArray display in dvanced Settings Editor 2018-04-18 08:57 PM

18752 Feature request Open Normal Implement a Command Palette into QGis 2018-04-18 02:31 PM

18752 Feature request Open Normal Implement a Command Palette into QGis 2018-04-18 02:31 PM

18660 Feature request Open Normal Layout map item: use crs selector widget for map grid 2018-04-07 10:01 AM

18660 Feature request Open Normal Layout map item: use crs selector widget for map grid 2018-04-07 10:01 AM

18624 Bug report Open Normal QGIS 3.0 Crash upon closing after having open large vrt raster 2018-04-04 03:29 PM

18624 Bug report Open Normal QGIS 3.0 Crash upon closing after having open large vrt raster 2018-04-04 03:29 PM

18593 Feature request Open Normal Add default shortcuts to copy and paste layers/group actions in Layer menu 2018-03-30 04:58 PM

18593 Feature request Open Normal Add default shortcuts to copy and paste layers/group actions in Layer menu 2018-03-30 04:58 PM

18592 Feature request Open Normal Add a Paste layer action in Layers contextual menu 2018-03-30 04:57 PM

18592 Feature request Open Normal Add a Paste layer action in Layers contextual menu 2018-03-30 04:57 PM

18590 Bug report Open Normal Copy/paste Layer/Group menus vs Duplicate layer(s) action: redundancy? 2018-03-30 10:45 PM

18590 Bug report Open Normal Copy/paste Layer/Group menus vs Duplicate layer(s) action: redundancy? 2018-03-30 10:45 PM

18585 Feature request Open Normal Column widths in Relations table (Project properties) should adapt automatically to the content 2018-03-29 06:08 PM

18585 Feature request Open Normal Column widths in Relations table (Project properties) should adapt automatically to the content 2018-03-29 06:08 PM

18564 Feature request Open Normal Can the currentLayer/selected layer be moved to next layer after a delete of a layer from the layertree 2018-03-28 12:55 PM

18564 Feature request Open Normal Can the currentLayer/selected layer be moved to next layer after a delete of a layer from the layertree 2018-03-28 12:55 PM

18552 Bug report Open High If make new systems in units=km, then scale in  view is very wrong.. 2018-03-27 06:53 AM

18552 Bug report Open High If make new systems in units=km, then scale in  view is very wrong.. 2018-03-27 06:53 AM

18481 Bug report Feedback High segfault when closing qgis 2019-03-11 11:38 AM
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18481 Bug report Feedback High segfault when closing qgis 2019-03-11 11:38 AM

18459 Feature request Open Normal Make the Symbol Layers List resizable 2018-03-16 12:45 PM

18459 Feature request Open Normal Make the Symbol Layers List resizable 2018-03-16 12:45 PM

18439 Bug report Open Normal Advanced setting editing are reset after closing of Options GUI 2018-03-14 01:21 PM

18439 Bug report Open Normal Advanced setting editing are reset after closing of Options GUI 2018-03-14 01:21 PM

18321 Feature request Open Normal Allow group selected layers with one layer selected 2018-03-03 03:15 PM

18321 Feature request Open Normal Allow group selected layers with one layer selected 2018-03-03 03:15 PM

18309 Bug report Open Normal QGIS3: menu is too long 2018-03-02 11:58 AM

18309 Bug report Open Normal QGIS3: menu is too long 2018-03-02 11:58 AM

18226 Bug report Open Normal Vertex Editor dialog does not respect its last placement Martin Dobias 2018-02-26 01:54 PM

18226 Bug report Open Normal Vertex Editor dialog does not respect its last placement Martin Dobias 2018-02-26 01:54 PM

18225 Bug report Open Low Python console text size bug 2018-02-26 12:33 PM

18225 Bug report Open Low Python console text size bug 2018-02-26 12:33 PM

18145 Bug report Open Normal Do not enable OK buttons if dialogs are missing required fields 2019-03-16 10:18 PM

18145 Bug report Open Normal Do not enable OK buttons if dialogs are missing required fields 2019-03-16 10:18 PM

18144 Bug report Open Normal Misleading UI on multiple layer vector dialog 2019-02-24 10:23 AM

18144 Bug report Open Normal Misleading UI on multiple layer vector dialog 2019-02-24 10:23 AM

18039 Bug report Open Normal Hiding a Map View removes it from project without a warning. 2018-03-03 09:32 PM

18039 Bug report Open Normal Hiding a Map View removes it from project without a warning. 2018-03-03 09:32 PM

17988 Feature request Open Normal Give better feedback to user when multiple records are updated via, for example, Update Selected in Attribute Table 2018-01-29 03:54 AM

17988 Feature request Open Normal Give better feedback to user when multiple records are updated via, for example, Update Selected in Attribute Table 2018-01-29 03:54 AM

17905 Bug report Open Normal [Attribute table] Missing data-defined icons in conditional formatting dialog 2019-03-09 06:58 PM

17905 Bug report Open Normal [Attribute table] Missing data-defined icons in conditional formatting dialog 2019-03-09 06:58 PM

17874 Bug report Feedback Normal No full support of HiDPI on Windows 10 2019-03-09 04:34 PM

17874 Bug report Feedback Normal No full support of HiDPI on Windows 10 2019-03-09 04:34 PM

17826 Feature request Open Normal [Vector Save As...] Missing icon for GeometryCollection type 2019-03-09 07:18 PM

17826 Feature request Open Normal [Vector Save As...] Missing icon for GeometryCollection type 2019-03-09 07:18 PM

17777 Bug report Feedback Normal Text goes over itself in text areas on display that has different display scaling than the main display. 2019-03-09 04:34 PM

17777 Bug report Feedback Normal Text goes over itself in text areas on display that has different display scaling than the main display. 2019-03-09 04:34 PM

17718 Bug report Open Normal CRS selector: Extent is not displayed for all CRS 2019-03-09 07:39 PM

17718 Bug report Open Normal CRS selector: Extent is not displayed for all CRS 2019-03-09 07:39 PM

17629 Bug report Feedback Normal 3D Map : Add tooltips for options 2019-03-09 04:34 PM

17629 Bug report Feedback Normal 3D Map : Add tooltips for options 2019-03-09 04:34 PM

17553 Bug report Feedback Normal [layer properties] Selected item in the Join tab is not highlighted 2019-03-09 04:28 PM

17553 Bug report Feedback Normal [layer properties] Selected item in the Join tab is not highlighted 2019-03-09 04:28 PM

17543 Feature request Open Normal Add an icon to 3D Map view  and show it on toolbar 2017-11-24 02:54 PM

17543 Feature request Open Normal Add an icon to 3D Map view  and show it on toolbar 2017-11-24 02:54 PM

17484 Bug report Feedback Normal Docked attribute table - not remembering position 2019-03-09 04:28 PM

17484 Bug report Feedback Normal Docked attribute table - not remembering position 2019-03-09 04:28 PM

17404 Bug report Feedback High Windows does not show unicode characters 2019-03-09 04:28 PM

17404 Bug report Feedback High Windows does not show unicode characters 2019-03-09 04:28 PM

17391 Bug report Open Normal icon size preview is kept when not selected in Options menu 2018-09-24 02:40 PM

17391 Bug report Open Normal icon size preview is kept when not selected in Options menu 2018-09-24 02:40 PM

17389 Feature request Open Normal Translatable strings: ensure a space is added after a colon (:) character 2017-11-03 08:33 AM

17389 Feature request Open Normal Translatable strings: ensure a space is added after a colon (:) character 2017-11-03 08:33 AM

17328 Feature request Open Normal Open and display "complex type" GeoTIFF 2017-10-25 12:06 PM

17328 Feature request Open Normal Open and display "complex type" GeoTIFF 2017-10-25 12:06 PM

17316 Bug report Open Normal Current implementation of multiple-layer style paste doesn't work for the command menu "Layer / Paste Style". 2019-01-24 12:20 PM

17316 Bug report Open Normal Current implementation of multiple-layer style paste doesn't work for the command menu "Layer / Paste Style". 2019-01-24 12:20 PM

17299 Bug report Open Normal Histogram for graduated style in layer properties disappears when the layer properties window is too small 2019-04-03 12:40 PM

17299 Bug report Open Normal Histogram for graduated style in layer properties disappears when the layer properties window is too small 2019-04-03 12:40 PM

17275 Feature request Open Normal Merge different progress bars 2017-10-13 11:17 AM

17275 Feature request Open Normal Merge different progress bars 2017-10-13 11:17 AM

17260 Feature request Open Normal [QGIS3 Unified add layer] Add a dedicated entry for opening spreadsheet 2017-10-08 10:10 PM

17260 Feature request Open Normal [QGIS3 Unified add layer] Add a dedicated entry for opening spreadsheet 2017-10-08 10:10 PM

17166 Feature request Open Normal Add Layer definiton button in data source manager 2017-09-21 11:00 AM

17166 Feature request Open Normal Add Layer definiton button in data source manager 2017-09-21 11:00 AM

17105 Feature request Open Normal Ability to set new layer path when adding layer from QLR file 2017-09-05 05:12 PM

17105 Feature request Open Normal Ability to set new layer path when adding layer from QLR file 2017-09-05 05:12 PM

17074 Feature request Open Normal Add "Draw on Canvas" option in Align Rasters dialog 2017-11-10 07:52 AM

17074 Feature request Open Normal Add "Draw on Canvas" option in Align Rasters dialog 2017-11-10 07:52 AM

17051 Feature request Open Normal make show/hide labels an checkbox 2017-08-24 04:41 PM

17051 Feature request Open Normal make show/hide labels an checkbox 2017-08-24 04:41 PM

17002 Feature request Open Normal Unified Add Layer: when using OgrConnection, embed the list of tables in the data source manager dialog 2017-08-12 07:10 PM

17002 Feature request Open Normal Unified Add Layer: when using OgrConnection, embed the list of tables in the data source manager dialog 2017-08-12 07:10 PM

17001 Feature request Open Normal Unified Add Layer: Use same credential frameworks for the NewOgrDatabaseConnection dialog 2017-08-12 07:11 PM

17001 Feature request Open Normal Unified Add Layer: Use same credential frameworks for the NewOgrDatabaseConnection dialog 2017-08-12 07:11 PM

16953 Feature request Open Normal Make overriding a layer's CRS harder so users don't change it when trying to transform 2018-10-25 12:59 PM

16953 Feature request Open Normal Make overriding a layer's CRS harder so users don't change it when trying to transform 2018-10-25 12:59 PM

16877 Feature request Open Normal Native XYZ provider only appears in browser. It should also be listed in new unified button 2019-03-01 11:09 AM

16877 Feature request Open Normal Native XYZ provider only appears in browser. It should also be listed in new unified button 2019-03-01 11:09 AM

16866 Bug report Feedback High RenderUnit::RenderMetersInMapUnits: no preview Image in Symbology-Dialog 2019-03-09 04:28 PM

16866 Bug report Feedback High RenderUnit::RenderMetersInMapUnits: no preview Image in Symbology-Dialog 2019-03-09 04:28 PM

16862 Feature request Open Normal User-Interface OWS Server Project Properties: Keyboard Navigation with TAB 2017-07-13 05:07 PM

16862 Feature request Open Normal User-Interface OWS Server Project Properties: Keyboard Navigation with TAB 2017-07-13 05:07 PM

16854 Feature request Open Normal Add toggle labels to layer context menu 2017-07-14 05:22 PM

16854 Feature request Open Normal Add toggle labels to layer context menu 2017-07-14 05:22 PM

16831 Bug report Feedback Normal SVG edit dialog will not size to screen 2019-03-09 04:28 PM

16831 Bug report Feedback Normal SVG edit dialog will not size to screen 2019-03-09 04:28 PM

16768 Bug report Feedback Normal No default application style setting (on windows?) 2019-03-09 04:28 PM

16768 Bug report Feedback Normal No default application style setting (on windows?) 2019-03-09 04:28 PM

16698 Bug report Feedback Normal When saving project, main windows changes size 2019-03-09 04:28 PM

16698 Bug report Feedback Normal When saving project, main windows changes size 2019-03-09 04:28 PM

16678 Bug report Feedback Normal Locator Filters option: Resizing the columns in the frame behaves weirdly 2019-03-09 04:28 PM

16678 Bug report Feedback Normal Locator Filters option: Resizing the columns in the frame behaves weirdly 2019-03-09 04:28 PM

16592 Feature request Open Normal Bring selected to top 2017-05-23 03:11 PM
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16592 Feature request Open Normal Bring selected to top 2017-05-23 03:11 PM

16583 Bug report Feedback Normal Unexpected error message when reloading QGIS from a crash 2019-03-09 04:28 PM

16583 Bug report Feedback Normal Unexpected error message when reloading QGIS from a crash 2019-03-09 04:28 PM

16490 Feature request Open Normal make the 'create scratch layer dialog' more like the 'create new shape file' dialog' 2017-05-02 09:39 AM

16490 Feature request Open Normal make the 'create scratch layer dialog' more like the 'create new shape file' dialog' 2017-05-02 09:39 AM

16475 Bug report Feedback Normal Vector Layer properties: Missing option in Source --> Settings frame 2019-03-09 04:28 PM

16475 Bug report Feedback Normal Vector Layer properties: Missing option in Source --> Settings frame 2019-03-09 04:28 PM

16278 Feature request Open Normal Spatial Bookmark Panel: add more precision & user interactivity 2017-05-01 12:44 AM

16278 Feature request Open Normal Spatial Bookmark Panel: add more precision & user interactivity 2017-05-01 12:44 AM

16193 Bug report Open Normal The new searchbox in the Layer properties dialog prevents minimization of the icons left panel 2019-03-02 11:14 AM

16193 Bug report Open Normal The new searchbox in the Layer properties dialog prevents minimization of the icons left panel 2019-03-02 11:14 AM

15994 Feature request Open Normal Add Close option to the Project menu 2017-05-01 12:44 AM

15994 Feature request Open Normal Add Close option to the Project menu 2017-05-01 12:44 AM

15968 Bug report Open Normal Identify results panel: tweaks for usability 2019-03-09 03:33 PM

15968 Bug report Open Normal Identify results panel: tweaks for usability 2019-03-09 03:33 PM

15967 Feature request Open Low Allow to set default sort column in Identify Window 2017-05-01 12:44 AM

15967 Feature request Open Low Allow to set default sort column in Identify Window 2017-05-01 12:44 AM

15704 Feature request Open Normal Shortcut to switch between layer visibility presets 2017-05-01 12:46 AM

15704 Feature request Open Normal Shortcut to switch between layer visibility presets 2017-05-01 12:46 AM

15406 Bug report Open Normal Identify panel: clicking on a curved line doesn't always show the radius Marco 

Hugentobler

2018-02-27 07:47 PM

15406 Bug report Open Normal Identify panel: clicking on a curved line doesn't always show the radius Marco 

Hugentobler

2018-02-27 07:47 PM

15356 Feature request Feedback Normal Add convenience shortcuts to layer/table context menu 2017-05-01 12:46 AM

15356 Feature request Feedback Normal Add convenience shortcuts to layer/table context menu 2017-05-01 12:46 AM

15180 Feature request Open Normal Customize the "Advanced Digitizing" icons for line and point layers 2017-05-01 12:46 AM

15180 Feature request Open Normal Customize the "Advanced Digitizing" icons for line and point layers 2017-05-01 12:46 AM

15170 Feature request Open Normal Add "Undo" button to Layer Properties 2017-05-01 12:46 AM

15170 Feature request Open Normal Add "Undo" button to Layer Properties 2017-05-01 12:46 AM

15169 Feature request Open Normal Add Toggle selected / checkmarked layers buttons in Layers Panel 2017-05-01 10:13 AM

15169 Feature request Open Normal Add Toggle selected / checkmarked layers buttons in Layers Panel 2017-05-01 10:13 AM

15167 Feature request Open Normal CTRL-A in Layers Panel should select all 2017-05-01 12:46 AM

15167 Feature request Open Normal CTRL-A in Layers Panel should select all 2017-05-01 12:46 AM

14972 Bug report Open Normal Layer Properties dialog > Legend tab: Used widget should not remain in the available list Martin Dobias 2019-03-10 12:24 AM

14972 Bug report Open Normal Layer Properties dialog > Legend tab: Used widget should not remain in the available list Martin Dobias 2019-03-10 12:24 AM

14865 Feature request Open Normal Improve new color ramp creation 2018-02-24 04:53 PM

14865 Feature request Open Normal Improve new color ramp creation 2018-02-24 04:53 PM

14749 Feature request Open Normal Rearrange icons in advanced digitizing toolbar 2017-05-01 12:46 AM

14749 Feature request Open Normal Rearrange icons in advanced digitizing toolbar 2017-05-01 12:46 AM

14717 Feature request Open Normal Add locking abilities for concurrent project access 2017-05-01 12:46 AM

14717 Feature request Open Normal Add locking abilities for concurrent project access 2017-05-01 12:46 AM

14638 Feature request Open Normal Add "Toggle feature selection" button to the Identify Results panel 2017-05-01 12:46 AM

14638 Feature request Open Normal Add "Toggle feature selection" button to the Identify Results panel 2017-05-01 12:46 AM

14636 Feature request Open Normal Add "Show/Hide labels" checkbox to layer context menu in layers panel 2017-05-01 12:46 AM

14636 Feature request Open Normal Add "Show/Hide labels" checkbox to layer context menu in layers panel 2017-05-01 12:46 AM

14613 Feature request Open Normal support tablet and pen when in "screen" mode 2017-05-01 12:46 AM

14613 Feature request Open Normal support tablet and pen when in "screen" mode 2017-05-01 12:46 AM

14472 Bug report Open Normal Attribute table icons too small on HiDPI 2018-07-22 11:09 PM

14472 Bug report Open Normal Attribute table icons too small on HiDPI 2018-07-22 11:09 PM

14284 Feature request Open Normal Add new group in Layers Panel above selected layer 2017-05-01 12:46 AM

14284 Feature request Open Normal Add new group in Layers Panel above selected layer 2017-05-01 12:46 AM

14155 Feature request Open Normal Composer Items Properties: Being able to change the height of some widgets 2017-05-01 12:46 AM

14155 Feature request Open Normal Composer Items Properties: Being able to change the height of some widgets 2017-05-01 12:46 AM

14070 Feature request Open Normal add buttons to layers panel to rearrange layers 2017-05-01 12:46 AM

14070 Feature request Open Normal add buttons to layers panel to rearrange layers 2017-05-01 12:46 AM

14027 Feature request Open Low save as KML data source options should use field list dropdown widget 2017-05-01 12:46 AM

14027 Feature request Open Low save as KML data source options should use field list dropdown widget 2017-05-01 12:46 AM

13629 Feature request Open Normal Composer Legend: Add a "Reset selected items" button to legend items 2017-05-01 12:47 AM

13629 Feature request Open Normal Composer Legend: Add a "Reset selected items" button to legend items 2017-05-01 12:47 AM

13628 Feature request Open Normal Composer legend: Unify "auto-update" checkbox and "update all" button 2017-05-01 12:47 AM

13628 Feature request Open Normal Composer legend: Unify "auto-update" checkbox and "update all" button 2017-05-01 12:47 AM

13532 Feature request Open Low Display number of selected features in layer tree 2017-05-01 12:46 AM

13532 Feature request Open Low Display number of selected features in layer tree 2017-05-01 12:46 AM

13478 Feature request Open Normal Please add a special section of the news: current crowdfunding projects 2018-02-25 07:12 PM

13478 Feature request Open Normal Please add a special section of the news: current crowdfunding projects 2018-02-25 07:12 PM

13465 Feature request Open High Identify Results panel : clicking on "Clear results" should close all feature attribute's form 2017-05-01 12:46 AM

13465 Feature request Open High Identify Results panel : clicking on "Clear results" should close all feature attribute's form 2017-05-01 12:46 AM

13424 Feature request Open Low UI option for clear "Recently used coordinate reference systems" list 2017-05-01 12:46 AM

13424 Feature request Open Low UI option for clear "Recently used coordinate reference systems" list 2017-05-01 12:46 AM

13371 Feature request Open Normal Move default style to themes folder Nathan 

Woodrow

2017-05-01 12:46 AM

13371 Feature request Open Normal Move default style to themes folder Nathan 

Woodrow

2017-05-01 12:46 AM

13125 Feature request Open Low Handle Bad Layers Dialog Improvements 2017-05-01 12:47 AM

13125 Feature request Open Low Handle Bad Layers Dialog Improvements 2017-05-01 12:47 AM

12981 Feature request Open Normal Manage Layer Visibility item under Layer menu 2017-05-01 12:47 AM

12981 Feature request Open Normal Manage Layer Visibility item under Layer menu 2017-05-01 12:47 AM

12967 Feature request Open Low Selection toolbar 2017-05-01 12:47 AM

12967 Feature request Open Low Selection toolbar 2017-05-01 12:47 AM

12781 Feature request Open Normal New histograms for rasters 2018-02-25 07:35 PM

12781 Feature request Open Normal New histograms for rasters 2018-02-25 07:35 PM

12405 Feature request Open Normal Disable the line edit about filepath destination in dialogs 2017-05-01 12:47 AM

12405 Feature request Open Normal Disable the line edit about filepath destination in dialogs 2017-05-01 12:47 AM

12351 Bug report Open Normal Weighted concentration renderer: difficult to remove weights 2018-03-07 05:36 PM

12351 Bug report Open Normal Weighted concentration renderer: difficult to remove weights 2018-03-07 05:36 PM

12320 Feature request Open Normal Let the user copy the whole measurements for lines 2018-03-06 06:34 PM
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12320 Feature request Open Normal Let the user copy the whole measurements for lines 2018-03-06 06:34 PM

12179 Feature request Open Normal Map rotation: more userfriendly interactive rotation tool Sandro 

Santilli

2017-05-01 12:47 AM

12179 Feature request Open Normal Map rotation: more userfriendly interactive rotation tool Sandro 

Santilli

2017-05-01 12:47 AM

12161 Feature request Open Low ESRI Filegdb should be listed under Database on Add Vector 2017-05-01 12:47 AM

12161 Feature request Open Low ESRI Filegdb should be listed under Database on Add Vector 2017-05-01 12:47 AM

12157 Feature request Open Normal Add "Select by Location" button to Attributes toolbar 2017-05-01 12:47 AM

12157 Feature request Open Normal Add "Select by Location" button to Attributes toolbar 2017-05-01 12:47 AM

11966 Feature request Open Normal Simple CRS List  feature requests 2017-05-01 12:47 AM

11966 Feature request Open Normal Simple CRS List  feature requests 2017-05-01 12:47 AM

11890 Feature request Open Normal Close without Saving lacks a keyboard shortcut 2017-05-01 12:47 AM

11890 Feature request Open Normal Close without Saving lacks a keyboard shortcut 2017-05-01 12:47 AM

11752 Feature request Open Low Save / export as image doesn't remember last used file type 2017-05-01 12:47 AM

11752 Feature request Open Low Save / export as image doesn't remember last used file type 2017-05-01 12:47 AM

11595 Feature request Open Normal Enhanced color table 2017-05-01 12:47 AM

11595 Feature request Open Normal Enhanced color table 2017-05-01 12:47 AM

11222 Feature request Open Normal make it possible to deactivate tips popup by command line option 2017-05-01 12:47 AM

11222 Feature request Open Normal make it possible to deactivate tips popup by command line option 2017-05-01 12:47 AM

11190 Feature request Open Normal Remember last selected format type for WMS/WMT-S for identify results 2017-05-01 12:47 AM

11190 Feature request Open Normal Remember last selected format type for WMS/WMT-S for identify results 2017-05-01 12:47 AM

11179 Feature request Open Normal Allow to define a tolerance for point selection 2017-05-01 12:47 AM

11179 Feature request Open Normal Allow to define a tolerance for point selection 2017-05-01 12:47 AM

10670 Feature request Open Normal status bar needs some love 2017-05-01 12:47 AM

10670 Feature request Open Normal status bar needs some love 2017-05-01 12:47 AM

10479 Feature request Open Normal Refine current rule Nathan 

Woodrow

2017-05-01 12:47 AM

10479 Feature request Open Normal Refine current rule Nathan 

Woodrow

2017-05-01 12:47 AM

10454 Feature request Open Normal New and improved save/export dialog Nathan 

Woodrow

2017-05-01 12:47 AM

10454 Feature request Open Normal New and improved save/export dialog Nathan 

Woodrow

2017-05-01 12:47 AM

10312 Feature request Open Normal Legend/Layer tree should show active rules used for rendering 2017-05-01 12:48 AM

10312 Feature request Open Normal Legend/Layer tree should show active rules used for rendering 2017-05-01 12:48 AM

10284 Feature request Open Normal Database relations: for 1:1 relations it should be possible to mix the widgets in the form 2017-05-01 12:48 AM

10284 Feature request Open Normal Database relations: for 1:1 relations it should be possible to mix the widgets in the form 2017-05-01 12:48 AM

10283 Feature request Open Normal Geometry widget 2017-05-01 12:48 AM

10283 Feature request Open Normal Geometry widget 2017-05-01 12:48 AM

10282 Feature request Open Normal Action widget in drag and drop form 2017-05-01 12:48 AM

10282 Feature request Open Normal Action widget in drag and drop form 2017-05-01 12:48 AM

10204 Feature request Open Low Better/faster keyboard support for editing values & labels in layer style 2017-05-01 12:48 AM

10204 Feature request Open Low Better/faster keyboard support for editing values & labels in layer style 2017-05-01 12:48 AM

10020 Feature request Open Normal Suggestion - change cursor to "busy" while calculating min/max range for raster layers 2017-05-01 12:47 AM

10020 Feature request Open Normal Suggestion - change cursor to "busy" while calculating min/max range for raster layers 2017-05-01 12:47 AM

9744 Feature request Open Normal Search as you type lookup in forms 2017-05-01 12:47 AM

9744 Feature request Open Normal Search as you type lookup in forms 2017-05-01 12:47 AM

9458 Feature request Open Normal Add more shortcuts buttons to field calculator and expression builder 2017-05-01 12:48 AM

9458 Feature request Open Normal Add more shortcuts buttons to field calculator and expression builder 2017-05-01 12:48 AM

9428 Bug report Open Normal Transparency of markers in marker line is neither applied nor stored Martin Dobias 2019-03-09 04:47 PM

9428 Bug report Open Normal Transparency of markers in marker line is neither applied nor stored Martin Dobias 2019-03-09 04:47 PM

9364 Feature request Open Low Provide a UI for creating custom Projection 2017-05-01 12:48 AM

9364 Feature request Open Low Provide a UI for creating custom Projection 2017-05-01 12:48 AM

9279 Feature request Open Normal Preselect field in Label dialogue 2017-05-01 12:48 AM

9279 Feature request Open Normal Preselect field in Label dialogue 2017-05-01 12:48 AM

9272 Feature request Open Normal Label style useful defaults 2017-05-01 12:48 AM

9272 Feature request Open Normal Label style useful defaults 2017-05-01 12:48 AM

9270 Feature request Open Normal Add basemaps always below vector-layers 2017-05-01 12:48 AM

9270 Feature request Open Normal Add basemaps always below vector-layers 2017-05-01 12:48 AM

9255 Feature request Open Normal Toolbar for map workspace 2017-05-01 12:48 AM

9255 Feature request Open Normal Toolbar for map workspace 2017-05-01 12:48 AM

9193 Feature request Open Low Differentiate add layer dialogs 2017-05-01 12:48 AM

9193 Feature request Open Low Differentiate add layer dialogs 2017-05-01 12:48 AM

9140 Feature request Open Normal Separating datasource, layer and style 2017-05-01 12:48 AM

9140 Feature request Open Normal Separating datasource, layer and style 2017-05-01 12:48 AM

9126 Feature request Open Normal Extend layer window with toolbar 2017-05-01 12:48 AM

9126 Feature request Open Normal Extend layer window with toolbar 2017-05-01 12:48 AM

9090 Feature request Open Normal Move 'add layers' to file menu 2017-05-01 12:48 AM

9090 Feature request Open Normal Move 'add layers' to file menu 2017-05-01 12:48 AM

9083 Feature request Open Normal Make contextmenus context aware 2017-05-01 12:48 AM

9083 Feature request Open Normal Make contextmenus context aware 2017-05-01 12:48 AM

9001 Feature request Open Low Make imported CSV tables editable within QGIS 2017-05-01 12:48 AM

9001 Feature request Open Low Make imported CSV tables editable within QGIS 2017-05-01 12:48 AM

8382 Feature request Open Normal Better way to remember last used choices for forms on adding feature 2017-05-01 12:48 AM

8382 Feature request Open Normal Better way to remember last used choices for forms on adding feature 2017-05-01 12:48 AM

8313 Feature request Open Low Allow access to the startup tips from the help menu 2017-05-01 12:48 AM

8313 Feature request Open Low Allow access to the startup tips from the help menu 2017-05-01 12:48 AM

8281 Feature request Open Normal Change the way .gpx and .kml are created 2017-05-01 12:48 AM

8281 Feature request Open Normal Change the way .gpx and .kml are created 2017-05-01 12:48 AM

8196 Feature request Open Normal Give us a panel that shows load times of layers 2017-05-01 12:48 AM

8196 Feature request Open Normal Give us a panel that shows load times of layers 2017-05-01 12:48 AM

8164 Feature request Open Normal Can't fix bad datasource info in qgs file through GUI 2017-05-01 12:48 AM

8164 Feature request Open Normal Can't fix bad datasource info in qgs file through GUI 2017-05-01 12:48 AM

7942 Feature request Open Normal In HTML windows add the option to open a link in an external browser 2017-05-01 12:48 AM

7942 Feature request Open Normal In HTML windows add the option to open a link in an external browser 2017-05-01 12:48 AM

7919 Feature request Open Normal Expose invert selection as a map tool Nathan 

Woodrow

2017-05-01 12:48 AM
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7919 Feature request Open Normal Expose invert selection as a map tool Nathan 

Woodrow

2017-05-01 12:48 AM

7898 Feature request Open Normal  New Vector Layer Window 2017-05-01 12:48 AM

7898 Feature request Open Normal  New Vector Layer Window 2017-05-01 12:48 AM

7776 Feature request Open Normal Standard reference system when new layers are created 2017-05-01 12:48 AM

7776 Feature request Open Normal Standard reference system when new layers are created 2017-05-01 12:48 AM

7662 Feature request Open Low Sensible default width and precision for real columns 2017-05-01 12:48 AM

7662 Feature request Open Low Sensible default width and precision for real columns 2017-05-01 12:48 AM

7145 Feature request Open High Show layer groups in "identifiable layers" and "snapping options" panels 2017-05-01 12:48 AM

7145 Feature request Open High Show layer groups in "identifiable layers" and "snapping options" panels 2017-05-01 12:48 AM

7094 Feature request Open Normal "All support formats" file open option 2017-05-01 12:48 AM

7094 Feature request Open Normal "All support formats" file open option 2017-05-01 12:48 AM

7050 Bug report Open Low Inconsistent use of strings 2019-03-09 03:25 PM

7050 Bug report Open Low Inconsistent use of strings 2019-03-09 03:25 PM

7044 Feature request Open Normal list all layers that the current layer is joined to 2017-05-01 12:48 AM

7044 Feature request Open Normal list all layers that the current layer is joined to 2017-05-01 12:48 AM

6959 Feature request Open Normal Merge attributes dialog should remember options for fields 2017-05-01 12:48 AM

6959 Feature request Open Normal Merge attributes dialog should remember options for fields 2017-05-01 12:48 AM

6951 Feature request Open Normal raster "save as..." to be improved when asking for output when using the "create VRT" option 2017-05-01 12:48 AM

6951 Feature request Open Normal raster "save as..." to be improved when asking for output when using the "create VRT" option 2017-05-01 12:48 AM

6912 Feature request Open Normal Add data provider field validation for Q[Plain]TextEdit widgets 2017-05-01 12:48 AM

6912 Feature request Open Normal Add data provider field validation for Q[Plain]TextEdit widgets 2017-05-01 12:48 AM

6713 Feature request Open Normal Rule based renderer gui enhancements: copy/paste; refine>use expression 2017-05-01 12:48 AM

6713 Feature request Open Normal Rule based renderer gui enhancements: copy/paste; refine>use expression 2017-05-01 12:48 AM

6706 Feature request Open Normal "View feature form" should be available for the "run feature action tool" 2017-05-02 03:29 PM

6706 Feature request Open Normal "View feature form" should be available for the "run feature action tool" 2017-05-02 03:29 PM

6650 Feature request Open Normal Layers window, horizontal scrollbar 2017-05-01 12:48 AM

6650 Feature request Open Normal Layers window, horizontal scrollbar 2017-05-01 12:48 AM

6648 Feature request Open Normal Warn about all existing files in save as 2018-02-26 10:42 AM

6648 Feature request Open Normal Warn about all existing files in save as 2018-02-26 10:42 AM

6616 Bug report Open Normal Preview in expression builder not always showing 2018-03-01 11:56 AM

6616 Bug report Open Normal Preview in expression builder not always showing 2018-03-01 11:56 AM

6499 Feature request Open Normal Allow choose the default measurement units to use 2017-05-01 12:48 AM

6499 Feature request Open Normal Allow choose the default measurement units to use 2017-05-01 12:48 AM

6424 Feature request Open Normal Show count in Identify Results dialog 2017-05-01 12:48 AM

6424 Feature request Open Normal Show count in Identify Results dialog 2017-05-01 12:48 AM

6390 Bug report Open Low Size of bar on canvas: weird behaviour 2019-03-09 04:22 PM

6390 Bug report Open Low Size of bar on canvas: weird behaviour 2019-03-09 04:22 PM

6231 Feature request Open Normal Should be able to use groups/filter etc to select styles for import/export 2017-05-01 12:48 AM

6231 Feature request Open Normal Should be able to use groups/filter etc to select styles for import/export 2017-05-01 12:48 AM

6081 Feature request Open Normal Allow manually change project CRS from project properties when OTFR is OFF 2017-05-01 12:48 AM

6081 Feature request Open Normal Allow manually change project CRS from project properties when OTFR is OFF 2017-05-01 12:48 AM

5975 Feature request Open Normal "Zoom history" panel like the "undo history" 2017-05-01 12:48 AM

5975 Feature request Open Normal "Zoom history" panel like the "undo history" 2017-05-01 12:48 AM

5935 Feature request Open Normal Make the default state of the topological editing configurable. 2017-05-01 12:48 AM

5935 Feature request Open Normal Make the default state of the topological editing configurable. 2017-05-01 12:48 AM

5787 Feature request Open Normal Trivalent checkbox for layer visibility 2017-05-01 12:48 AM

5787 Feature request Open Normal Trivalent checkbox for layer visibility 2017-05-01 12:48 AM

5569 Feature request Feedback Normal Turn all attribute table buttons into right click options 2017-05-01 12:48 AM

5569 Feature request Feedback Normal Turn all attribute table buttons into right click options 2017-05-01 12:48 AM

5559 Feature request Open Low add tooltip on fields in identify window / attribute window / feature form 2017-05-01 12:48 AM

5559 Feature request Open Low add tooltip on fields in identify window / attribute window / feature form 2017-05-01 12:48 AM

5516 Feature request In Progress Low Better sorting of menus 2018-02-24 03:18 PM

5516 Feature request In Progress Low Better sorting of menus 2018-02-24 03:18 PM

5249 Feature request Open Normal No default Point geometry when creating a new Vector layer 2017-05-01 12:50 AM

5249 Feature request Open Normal No default Point geometry when creating a new Vector layer 2017-05-01 12:50 AM

5005 Feature request Open Normal Display layer's native CRS, and provide the ability to remove any override 2018-01-10 03:48 AM

5005 Feature request Open Normal Display layer's native CRS, and provide the ability to remove any override 2018-01-10 03:48 AM

4900 Feature request Feedback Normal Have 1 (non-hidden) QGIS folder with a fixed set of subdirs for icons, templates, styles, plugins ... 2018-04-16 03:37 PM

4900 Feature request Feedback Normal Have 1 (non-hidden) QGIS folder with a fixed set of subdirs for icons, templates, styles, plugins ... 2018-04-16 03:37 PM

4713 Feature request Open Normal Add user registration and utilities to current Help>Info menu 2018-02-24 04:00 PM

4713 Feature request Open Normal Add user registration and utilities to current Help>Info menu 2018-02-24 04:00 PM

4649 Feature request Open Normal Drop file to Layers not possible when panel is floating 2017-05-01 12:50 AM

4649 Feature request Open Normal Drop file to Layers not possible when panel is floating 2017-05-01 12:50 AM

4609 Feature request Open Normal Add a filter for the "values" list in the query builder and similar dialogs 2017-05-01 12:50 AM

4609 Feature request Open Normal Add a filter for the "values" list in the query builder and similar dialogs 2017-05-01 12:50 AM

4270 Feature request Open Normal Attribute Table - make keyboard cell navigation more consistent 2017-05-01 12:50 AM

4270 Feature request Open Normal Attribute Table - make keyboard cell navigation more consistent 2017-05-01 12:50 AM

4100 Bug report Open Normal Text for two CRS dialogues is wrong (swapped) 2019-03-10 05:53 PM

4100 Bug report Open Normal Text for two CRS dialogues is wrong (swapped) 2019-03-10 05:53 PM

4069 Feature request Reopened Normal Enhancement: ability to search for a plugin to run 2018-04-03 11:55 PM

4069 Feature request Reopened Normal Enhancement: ability to search for a plugin to run 2018-04-03 11:55 PM

3824 Feature request Open Low make it possible to see & change layer CRS directly from layer menu 2017-05-01 12:50 AM

3824 Feature request Open Low make it possible to see & change layer CRS directly from layer menu 2017-05-01 12:50 AM

3806 Feature request Open Low Make click anywhere in symbol select/identify the object (i.e. when symbol is bigger than the actual object) 2018-03-03 09:26 AM

3806 Feature request Open Low Make click anywhere in symbol select/identify the object (i.e. when symbol is bigger than the actual object) 2018-03-03 09:26 AM

3805 Feature request Open Low Snapping for select and info tools nobody - 2017-05-01 12:42 AM

3805 Feature request Open Low Snapping for select and info tools nobody - 2017-05-01 12:42 AM

3780 Feature request Open Low Allow non-point map features for annotations 2017-05-01 12:50 AM

3780 Feature request Open Low Allow non-point map features for annotations 2017-05-01 12:50 AM

3629 Feature request Feedback Low Double-click zoom 2017-05-01 12:50 AM

3629 Feature request Feedback Low Double-click zoom 2017-05-01 12:50 AM

3567 Feature request Open Low Thousands separator 2017-05-01 12:50 AM

3567 Feature request Open Low Thousands separator 2017-05-01 12:50 AM

2403 Feature request Open Low Locale settings not working as it should nobody - 2017-05-01 12:42 AM
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2403 Feature request Open Low Locale settings not working as it should nobody - 2017-05-01 12:42 AM

2058 Feature request Open Low inconsistency in the GUI: commas and full stops 2018-03-07 04:22 PM

2058 Feature request Open Low inconsistency in the GUI: commas and full stops 2018-03-07 04:22 PM

1893 Bug report Reopened Low opening data tables widens the main window 2019-03-09 03:21 PM

1893 Bug report Reopened Low opening data tables widens the main window 2019-03-09 03:21 PM

1828 Feature request Open Low "For in the field" mode nobody - 2017-05-01 12:42 AM

1828 Feature request Open Low "For in the field" mode nobody - 2017-05-01 12:42 AM

1734 Feature request Open Low Use a dockable tabbed window for plugins 2017-05-01 12:50 AM

1734 Feature request Open Low Use a dockable tabbed window for plugins 2017-05-01 12:50 AM

1622 Feature request Open Low Implement capability to add tabs in the main window lynxID - 2018-07-20 12:48 PM

1622 Feature request Open Low Implement capability to add tabs in the main window lynxID - 2018-07-20 12:48 PM

1585 Bug report Open Low add missing svg image sources 2018-07-20 12:48 PM

1585 Bug report Open Low add missing svg image sources 2018-07-20 12:48 PM

1337 Feature request Open Low User-defined zoom limit 2017-05-01 12:50 AM

1337 Feature request Open Low User-defined zoom limit 2017-05-01 12:50 AM
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